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ABSTRACT

This document outlines the basic hardware and software components for the BOOSTXL-TPS65033 Socketed
Programming Board. The BoosterPack enables pre-assembly programming for both the TPS650320-Q1 and the
TPS65033x-Q1 devices. The TPS65032001-Q1 and TPS65033000-Q1 are re-configurable PMICs for
prototyping various device settings. The settings can then be provided to Tl for a final production PMIC.
Alternatively, the TPS65032001-Q1 and TPS65033000-Q1 devices can be programmed in production to match a
wide range of application requirements. The non-safety versions of the TPS650320-Q1 and TPS65033x-Q1 will
similarly allow programming of production units.

Table of Contents

1 BOOSTXL-TPS65033 Components and ENVIFONMENL.....................ooiiiiiiiiiiii e et e e 2
2 BOOSTXL-TPS65033 Board INfOrmation...............oooiiiiiiiiiiiiii et e et e e st e e e sne e e e snte e e eneeeenneeean 2
2.1 Critical Socketed Board CONMNECHONS. .........ii ittt e s e et e st eeen e e e s et e e s aeeeeanteeeeneeeeanseeeaneeeeanneeeenneeeenn 3
2.2 JUMPETS @NA TEST POINTS.....eieiiiiiiiiieiii ettt e et e e e e e e e e e e e e e s s s e e eaaeeebeaeaeeeeeeeeaeaaaaaeeeeaeesasaaaaaassnsnsnsnsnnnnnnnnnes 4
3 Programming GUI OPeratioN..............oooiiiiiiiii ettt e e ettt e e sae et e e bt e e e nt e e e emseeeateeeeamteeesmneeeeaseeeeanteeeaneeeeanneeas 5
BT I o 11 =TI T=Y T o TSSO PP PRSPPI 5
T2 7o) 1T Tox 110) N 1= o 10 o T 19T TSR 9
3.3 Basic Operation Of the GUIL.........ccuuiiii et e e e e e e e e e e et e e e e e e eaat e e e e e e sabaeeeeeseeaasseeeeeennnreeeeas 10
B 0 S Yo7y o 1o A OSSR 16
4 Recommended Operating ProCEAUIE..............c.ooi ittt e e e et e e et e e e amte e e snneeeesnaeeeanneeesnseeeanneeas 19
5 BOOSTXL-TPSB65033 SCREMALIC. .........ooiiiiiiiiii ettt et e e et e e e ae e e e sn bt e e e nee e e neeeeanseeeenteeennneeeaneeeens 20
6 BOOSTXL-TPS65033 BOArd LAYEIS...........cooiiuiieiiiiieiiieeeiiee e etieeeatie e e aee e st e e e et e s anteeesmteeeaseeeeamseeeamneeeeanseeeanneeesnneeeeanneeeans 22
7 BOOSTXL-TPS65033 Bill Of Materials..............cocuoiiiiiiiii ettt e s e e et e e s e et eeeneeeeeneeas 26
B REVISION HISTOKY ... ... i ettt e oo b et e e o e a b ettt e e e e e a b bttt e e e e ba bt e e e e e e anb b e e e e e e aanbeneeeeeanntneeeas 28
Trademarks

Google Chrome™ is a trademark of Google, LLC.

Mozilla Firefox™ is a trademark of Mozilla Foundation.
Windows® is a registered trademark of Microsoft Corporation.
macOS® is a registered trademark of Apple Inc.

Linux® is a registered trademark of The Linux Foundation.

All other trademarks are the property of their respective owners.

SLVUBO3A — APRIL 2019 — REVISED OCTOBER 2020 BOOSTXL-TPS65033 User's Guide 1
Submit Document Feedback

Copyright © 2020 Texas Instruments Incorporated


https://www.ti.com
https://www.ti.com/feedbackform/techdocfeedback?litnum=SLVUBO3A&partnum=

I3 TEXAS
INSTRUMENTS
BOOSTXL-TPS65033 Components and Environment www.ti.com

1 BOOSTXL-TPS65033 Components and Environment

The TPS65032001-Q1 and TPS65033x-Q1 family of PMICs are configurable and programmable only through
12C instructions. The BOOSTXL-TPS65033 socketed board is designed to act as a BoosterPack to the low cost
Tl LaunchPads, enabling a LaunchPad to act as the USB-to-12C interface for communication with a personal
computer. This separation reduces the cost of prototyping and enables experimentation with various Tl devices,
including custom software development using existing LaunchPad tools. Many of these tools can be found online
at Tl DevTools. The programming GUI is also available in the Tl DevTools Gallery. This GUI is compatible with
both the MSP430F5529LP and the MSP432E401Y LaunchPads.

2 BOOSTXL-TPS65033 Board Information

The BOOSTXL-TPS65033 is designed to stack on top of a LaunchPad, connecting the relevant power and MCU
pins to the PMIC through the headers J1/J3 and J2/J4. Power is delivered to the PMIC from the USB port of a
PC through the the LaunchPad 5 V and 3.3 V rails. The following block diagram demonstrates how the
LaunchPad interfaces with the PC and the PMIC.
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Figure 2-1. Programming Board and LaunchPad Connections

2.1 Critical Socketed Board Connections

Critical connections for operating the socketed board are the 5V rail, the 3.3 V rail, and the 12C pins. The
remaining connections to the LaunchPad are left available for future experimentation. Note: I12C pull-ups must be
pulled up to VIO. This can optionally be pulled up to 3.3 V (default) or an alternate rail through the J12.

By default, the 3.3 V rail must be present to power the VIO and GPIO pins to fully enable the PMIC. If evaluation
without a PC is desired, both the 5 V and the VIO domains should be externally supplied. If VIO is supplied by a
voltage other than 3.3 V, J12 should be left open to prevent potential current paths to the MCU 3.3 V. For most
configurations, the PMIC can supply VIO when externally connected to an appropriate test point, for example the
Buck 1 output if configured for 3.3 V, or the Buck 2 output if configured for 1.8 V.
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2.1.1 Power Switches

Both the 5 V and 3.3 V rails connect to the PMIC through separate current limiting load switches. The load
switches are simultaneously enabled with the S2 toggle switch on the top left area of the board. See Section 5
for the complete BOOSTXL-TPS65033 schematic. It is recommended to keep S2 open when connecting the
LaunchPad to the PC to reduce the initial current draw from the USB port.

2.2 Jumpers and Test Points
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Figure 2-2. Programming Board Test Points and Jumpers
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3 Programming GUI Operation
3.1 Initial Set-up
3.1.1 Finding the GUI

The Graphical User Interface (GUI) for the BOOSTXL-TPS65033 can be found in the Gallery at TI DevTools.
This GUI will connect to the BOOSXL-TPS65033 provided a compatible 12C controller is connected
(MSP430F5529LP, MSP432E401Y, or USB2ANY). This GUI is also compatible with the TPS650320Q1EVM and
TPS650330Q1EVM, which both have on-board MSP432E401Y MCUs.

The GUI can be operated through Google Chrome™ or Mozilla Firefox™ web browsers. To run the GUI in the
browser, click the thumbnail and follow the prompted instructions for first time installation. The GUI requires both
a browser plugin and the Tl Cloud Agent software for access to the local USB ports. The GUI can also be
downloaded for offline operation by hovering over the downward arrow in the GUI thumbnail and selecting the
desired platform — Windows®, macOS®, or Linux®.

3.1.2 Offline Installation

To download the offline installer, click the downward arrow on the below the thumbnail and select the relevant
operating system for the destination PC.

=1E4(0)

Figure 3-1. Standalone Installer Download Icon

The platform downloads will include the GUI Composer runtime installer if internet access is available during
installation. If the PC has no internet access at time of installation, the runtime installer may need to be
downloaded in advance using the additional links below the platform installation URLs.

Select the platform to download

* Linux 64bits
* Mac
* Windows

This software requires GUI Composer
runtime v7.1.0. You can download it during
the installation of this software.
Alternatively, you can get the runtime here.

* Linux 64bits runtime
* Mac runtime
* Windows runtime

Figure 3-2. Standalone Installer Operating System Options
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3.1.3 Flashing the MSP430F5529 LaunchPad

Initial operation with the MSP430F5529 LaunchPad requires downloading pre-configured firmware into the
MSP430 in order to be recognized by the GUI.

The GUI incorporates a tool to flash the MSP430F5529 LaunchPad, located under the File tab in the top menu.
This tool is pre-configured to flash the MSP430F5529LP only, and cannot be used with other LaunchPads.

File Options Tools Help

3 Load Setfings ...

a Save Seffings ..

’ Program Device...

Download target program.

I Load Registers
a Save Registers

a Save Registers As...

Figure 3-3. LaunchPad Firmware Flashing Tool

To flash the LaunchPad, first connect the MSP430F5529LP to the PC using a micro-USB cable, then select File
> Program Device. The GUI will automatically download the firmware, recognize the LaunchPad, and flash the
board.

Afterwards the LaunchPad will be recognized as the specific USB-to-12C interface for operating with the
TPS65032001-Q1 and TPS65033x-Q1 PMICs.

3.1.4 Flashing the MSP432E401Y Launch Pad

Initial operation with the MSP432E401Y LaunchPad requires downloading pre-configured firmware into the
MSP432 in order to be recognized by the GUI. See Section 3.1.2 about how this firmware must be accessed by
installing the GUI for offline operation.

1. Once downloaded, the MSP432 firmware file, acctrl_4 18.bin, can be found at:{ Installation
Directoryl}\install image TPS6503xx-Ql GUI.zip\TPS6503xx-Ql GUI\app\firmware

2. Install UniFlash, a free firmware flashing tool from TI.

3. Connect the LaunchPad to the PC. Use the USB port on the MSP432E401Y LaunchPad that is opposite the
Ethernet port.

4. Run UniFlash. The program should automatically detect the connected MSP432E401Y LaunchPad. Once
detected, click Start.
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Device: MSP-EXP432E407Y LaunchPad rev 1.0
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= New Configuration
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Figure 3-4. UniFlash Initial Setup

5. On the next page, browse to the binary file downloaded in Step 1 and click Load Image.
2 niFtash

UniFlash  Session = About @ lielp

£ Settings

Configured Device : Texas Instruments XDS5110 USB Debug Probe > MSP432E401Y [download ccxml] CORTEX_M4_D

I Program Select and Load Images
Settings & Utilities Flash Image(s)
Memory acctrl_4_18.bin Size: 62.55 KB | Binary: @ | Load Addr X
Standalone Command Line
Available Action(s) - 1 Image Selected
Load Image Verify Image
Reset Actions
IClick here to query available reset options|
Run Actions
B4 Run Target After Program Load/Flash Operation
1 Console 4 Verbose * Close

Figure 3-5. UniFlash Load Firmware Image

6. If prompted, update the XDS110 Debugger firmware. After accepting the update, UniFlash will update the
firmware automatically and continue to load the binary image. The console will indicate a successful program.
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< Verbose = Clear X Close

) Console

[10/5/2020, 1:12:36 PM]

compatible with this soft tton to update
[10/5¢/2020, 1:12:58 PM] [INFO] CORTEX_M4_0: GEL Output: Memory Map Initizlization Complete
[10/5/2020, 1:13:01 PM] [SUCCESS] Program Load completed succassfully.

Figure 3-6. UniFlash Successful Program
7. Unplug the micro USB cable from the MSP432E401Y LaunchPad.
8. Now plug the USB cable in to the micro USB port adjacent to the Ethernet port.
9. Install jumper on pins 3-4 (USB-OTG) of JP1 to supply the target 5 V supply through USB.

After completing this process, the GUI will recognize the LaunchPad as a USB-to-12C interface. Next, stack the
BOOSTXL-TPS65033 on top of the MSP432E401Y LaunchPad. The headers should align according to Table
3-1.

Table 3-1. BoosterPack to MSP432E401Y LaunchPad Connections

BOOSTXL-TPS65033 Pin Header MSP432E401Y LaunchPad Pin Header
J1 J5
J2 J6
J3 J7
J4 J8

Note there may be two separate interfaces (or COM ports) recognized by the GUI. If one is failing to connect,
use the GUI to switch to an alternate port.

1. Click the Options menu at the top of the GUI, select Serial Port.

Options Tools Help

= Me Ty Serial Port ..

Configure Port and Baud Rate

©

'm

Figure 3-7. Serial Port Options
2. Use the Ports dropdown to select the alternative interface.
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Serial Port Configuration

Ports: |COM27 féevm} vus

Baud Rates: |COMS3 (Intel) ed) v

COM26 (aevm)

REFRESH COM27 (aevm) CANCEL

Figure 3-8. GUI Serial Port Selection
3. The GUI will indicate a successful connection through the black connection toolbar.

m GO ~ (COM27:9600 Hardware Connected.

Figure 3-9. Hardware Connected Indicator

3.2 Connection Debugging

The connection link in the black toolbar at the bottom of the GUI can be toggled to refresh the connection to the
LaunchPad. The flow chart in Figure 3-11 can aid in debugging potential connection issues with the BOOSTXL-
TPS65033.

M |GD| -~ COM27:9600 Hardware Connected.

Figure 3-10. Refreshing the GUI-to-MCU Connection
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Figure 3-11. BOOSTXL-TPS65033 Connection Debug Flow Chart

3.3 Basic Operation of the GUI

The GUI displays a README.md prompt each time the GUI is launched. The prompt can be disabled for
subsequent sessions by selecting the | checkbox at the bottom of the window. The README.md information is
always available in the Help tab at the top of the GUI.

The GUI automatically attempts to connect to the flashed LaunchPad, with the connection status displayed in the
bottom left hand corner of the GUI window. Once connected to the LaunchPad, the GUI attempts to read the
register information of the PMIC populated in the socket. If the PMIC appears unresponsive, verify the serial port
connection and confirm that all relevant shunts are populated according to Figure 2-2. If all shunts are populated
properly, pressing the RST button on the LaunchPad (S3) below the socketed board can often recover USB
communication.

3.3.1 Home

The Home section is the landing page of the GUI. Here the GUI presents an overview of the EVM and
Programming BoosterPack (BOOSTXL-TPS65033), and emphasize navigation to the remaining four sections
through the tiles on the bottom of the page.
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TPS650320-Q1 + TPS65033x-Q1 EVM and BoosterPack GUI

.y .
Fguesee 0w

8 / = 5

Block Diagram Registers Device Configuration Re-Program PMIC

Figure 3-12. TPS6503xx-Q1 GUl Home Screen

3.3.2 Block Diagram

The Block Diagram section displays the typical components and functional blocks of the PMIC. A block diagram
for the Programming BoosterPack is also shown.

= Mern

# | B Block Diagram

©

s

A5 Tuas Insrumers

Figure 3-13. TPS6503xx-Q1 GUI Block Diagram Page
3.3.3 Registers

The Registers section provides an overview of the internal register map, and includes basic interfaces for each
PMIC register. Figure 3-14 illustrates the register page and the primary interactive regions.
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Figure 3-14. Register Page Interfaces

The register table displays each register name, address, last known value from the PMIC, and corresponding bit
values. Selecting a title or bit fields in the table will update the Field View column on the right side of the GUI.
The Field View displays the individual fields contained within the associated register address. Within the register
page, clicking a blue icon containing a question mark (?) will expand additional descriptions if available. The
expanded description views can then be closed by clicking the red (x) icon.

This register page can poll the device periodically using the Aufo Read feature in the top right corner, or allow
manual read instructions using the Read Register and Read All Registers buttons.

A drop-down menu selection at the top right of the register map indicates how the registers are written as the
user interacts with the register page. With Immediate selected, any update to the register page is automatically
sent to the PMIC, whereas Deferred will wait for the Write Register or Write All Registers instructions before
communicating with the device. After each write, the register page will automatically read the affected register
address to confirm the latest value in the device.

3.3.4 Device Configuration

The Device Configuration section is organized into selectable tabs at the top of the page, where only the
contents of the blue tab is actively displayed. Each tab contains categorized visual instruments relating to
individual bit fields within the register map. Each instrument is linked to the latest bit values in the register map
table, and can be used to alter settings within the PMIC through the dropdown menus or check box features. If
the Auto Read function in the register map is inactive, the Read All Registers button in the top right area of the
Device Configuration page can be used to manually refresh the register page, which will then update the
instruments with the latest device values.

The PMIC incorporates Control Lock and Configuration Lock features that can prevent 12C writes to various
registers within the device. The status of these locks will always be displayed in the top right hand corner of the
Device Configurations page, and can be toggled by clicking their associated checkbox. When the GUI is properly
connected to the EVM and write instructions appear to be ignored by the PMIC, confirm the status of these
indicators to verify the device is able to accept new write instructions.
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Figure 3-15. TPS6503xx-Q1 GUI Device Configuration Page

3.3.4.1 Using Device Configuration to Define Spin Settings

In some circumstances, Tl may provide customized, pre-programmed devices for the camera application.
Contact a local Tl sales representative for more information.

The Device Configuration tabs in the GUI can be used to define custom settings for Tl to pre-program into the
device Non-Volatile Memory (NVM). Before beginning the spin definition, see the Camera PMIC Spin Selection
Guide to determine if there is an exisiting spin that is already compatible with the target application and the
image sensor or both.

Since the visual instruments in the Device Configuration page link directly to the corresponding bits and registers
in the Register Map page, the Device Configuration page can be used to quickly define desired OTP register
settings.

1. Select the desired camera PMIC from the drop-down menu above the tab indicators to start. The GUI will
automatically show, hide, or disable features corresponding to the selected PMIC. This drop down box will not
be adjustable if a device is connected to the GUI.
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File Options Tools Help
= Menu

# == Device Configuration

Device Selection for Generating NVM Settings: | TPS650332-01  +

TPS650320-01
BUCK 1

TPS650330-01

/7
2 cy Masks Interrupt Flags Fault Status
BUCK 1 Enabled TPS650331-Q1 y. ptriags —
[
@ Output Voltage 330V ~ TPS650332-Q1 ® Under Voltage
R ® wam ® Mask Warm
TPS650333-01
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UVLO Falling 40V v SEQ Fin }
@ Input Under Voltage
Sequence On Delay 0.5ms ~
Sequence Off Delay s e e Over Voltage Status

Figure 3-16. Device Selection for Generating NVM Settings
2. Select the desired regulator, sequencing, and additional feature settings in each of the tabs. These changes
will be reflected in the Register Map page. For determining the power sequence settings, see Section 3.3.4.2.
3. Click File > Save Settings in the top left corner of the GUI. This exports the register settings in a JSON file
that is provided to generate the NVM spin.

"] settings.json - Notepad - O *

File Edit Format View Help
{ A
"my_model”: {
"$refresh_interval™: -1,
"PID": 248,
"RID": 8,
"CONTROL_LOCK": @,
"BUCK_LDO_CTRL": 31,
"GPIO_CTRL": 31,
"CONFIG_LOCK": @,
"LDO_GPIO_CFG": 29,
"BUCK1_VOUT": 16,
"BUCK1_UVLO™: 18,
"BUCK2_VOUT": 29,
"BUCK3_VOUT": 18,
“LDO_VOUT": 14,
"DISCHARGE_SETTING™: 85, v

Ln 37, Col 33 100%  Unix (LF) UTF-8

Figure 3-17. Example Settings Output
3.3.4.2 Configuring the Power Sequence

The Sequencing Overview tab includes instruments to customize the power sequence of the PMIC. Note that the
check boxes are power sequence masks. If a particular logic signal needs to be included as part of the regulator
or logic power up sequence, leave the box next to the logic signal unchecked. Tl recommends to set Power On
Bit unmasked for each rail that is required in the application.
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Figure 3-18. Sequencing Overview Tab
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When using a TPS65033x-Q1 device, the GPIO pin can also be used for power sequencing of an external
regulator or other device. In the Special Features tab, configure GPIO as an output to include its sequencing in
the Sequencing Overview tab. Note that when using GPIO for sequencing, the GPIO Function must be Enabled.
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Figure 3-19. Sequencing Overview Including GPIO

For reference, the GUI can generate example power-up and power-down timing diagrams based on the
sequence settings present when the UPDATE TIMING DIAGRAM button is clicked. As noted, rise and fall times
are approximate, and the maximum sequence length is 200 ms. Changes to regulator enable and output
discharge settings are reflected in the timing diagram. If the sequence settings are not valid, the GUI will provide
a notifying message and the timing diagram will not be updated. For example, if a regulator is enabled but fails

to power-up within 200 ms, the sequence settings are not valid.
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Figure 3-20. GUI Generated Timing Diagram

3.4 Scripting

The GUI includes a scripting feature in the tools menu at the top of the window. Scripting enables automated

writes and reads to the PMIC, allowing sequential instructions to be sent to the PMIC. Scripts can be saved as
a .js or .txt file, and imported using the Upload arrow at the top of the scripting window. Scripting allows the re-
configuration of multiple PMICs before sending to assembly or populating on a PCB.

TPS650320-Q1 + TPS65033x-Q1 EVM and BoosterPack GUI
® |

ok oK R o ok ok K Rk KR KKK K R

File Options

+

Camera_PMIC_Config_CRC_Generator.js vt

T
* To add additional script to the scripting widget, create/upload a
* to the 'scripts' folder. Open the scripting.html file in the editol
* the file in the Project view. Append the filename to the 'scripts’

* ti-widget-scripting element, separated each script filename by a cd
S R R R R K R R R R R R R R R K R K R R R

-

'Script Started';
"Script Ended';

const SCRIPT_START_MESSAGE
const SCRIPT_END MESSAGE
const PID_TPS6508333 = 0xFO;

W N TN e W

var reg_data = [];
13 var crc = 9x00;

14

15

16 function main() {

L s

18 * To debug this script, open the debugger in the main applicatior

E 19 * spawned this window. For mest browser, press F12 to enable debi
I_ CLOSE

Block Diagram URegISTers Device tonmiguration

Figure 3-21. TPS6503xx-Q1 GUI Scripting Window
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An example script for re-programming a device can be seen below, where output voltages and sequencing
settings are reconfigured from the default settings.

/* Entry point for the script, which will be executed when the user presses the PLAY button in the
Scripting Dialog. */

function main () {

write ('CONTROL LOCK', 0xDD); // Unlock control registers

write ('CONFIG LOCK', OxAA); // Unlock configuration registers

write ('GPIO _CTRL',2); // Disable configuration CRC

write ('BUCK LDO CTRL',0x00) ; // Turn off all regulators to prevent faults
write ('BUCK3_VOUT',6); // Change Buck 3 output voltage

write ('LDO_VOUT', 8); // Change LDO output voltage

write ('SEQ TRIG BUCK2',10); // Update Buck 2 sequence dependencies
write ('SEQ TRIG BUCK3',2); // Update Buck 3 sequence dependencies
write ('SEQ TRIG_LDO',26); // Update LDO sequence dependencies
write ('SEQ TRIG nRSTOUT',2); // Update nRSTOUT sequence dependencies
write ('BUCK1_SEQ DLY',145); // Update Buck 1 sequence delay

write ('BUCK2_ SEQ DLY',86); // Update Buck 2 sequence delay

write ('BUCK3 SEQ DLY',54); // Update Buck 3 sequence delay

write ('LDO_SEQ DLY',118); // Update LDO sequence delay

write ('nRSTOUT SEQ DLY',6); // Update nRSTOUT sequence delay

write ('BUCK LDO CTRL',31); // Re-enable all regulators

write (' EEPROM PROG CMD',45) ; // Burn settings into EEPROM

}

Figure 3-22 details the typical device programming flow. Most blocks can be executed with one or more register
write commands in the script file. Only the J2 configuration and GPIO trigger application cannot be done via
scripting.
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16 write('WD_MODE_REG',0x01);
17 write('WD_MODE_REG',0x05);
18 write( 'WD_THR_CFG',0xBF);
Apply appropriate
trigger to GPIO
19 write('CONTROL_LOCK', @xDD);
20 write('CONFIG_LOCK', ©xAA); |,
23 write('BUCK_LDO_CTRL',0@x00);
25 write('BUCK3_VOUT',6);
26 write('LDO_VOUT',8);
27 write('SEQ_TRIG_BUCK2',10);
Enable all regulators 37 write('BUCK_LDO_CTRL',31);
write('CFG_REG_CRC', new_crccode);
38 write('EEPROM_PROG_CMD',45);
Figure 3-22. Example Script Program Flow
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4 Recommended Operating Procedure

* Due to the parasitic elements introduced by the BOOSTXL-TPS65033 socket, it is recommended
to use the BOOSTXL-TPS65033 board primarily for digital evaluation. This includes features like
NVM programming, state machine behavior, diagnostics, and fault handling.

» For analog performance evaluation of the PMIC, please refer to the TPS650320-Q1 EVM and the
TPS650330-Q1 EVM.

1. Connect the socketed board to the MSP430F5529 LaunchPad by aligning placing the socketed board on top
of the LaunchPad, aligning the J1/J3 and J2/J4 headers, and pressing the two boards together. For the
MSP432E401Y, align with the J5/J7 and J6/J8 headers.

2. Ensure S1, S2, and S3 of the socketed board are not asserted (down position), and connect the LaunchPad
to the PC using a micro-USB cable. A TPS65032001-Q1 or TPS65033x-Q1 device may be inserted into the
socket at any time that S2 is open and proper ESD considerations are observed. Ensure the unit's Pin 1
indicator is aligned with the Pin 1 silkscreen indicator on the lower left corner of the socketed board.

3. Ensure the Device Selection jumper (J2) matches the generic part number of the device populated in the
socket.

4. If this is the first time using the LaunchPad with the TPS6503xx-Q1 GUI, flash the LaunchPad using the steps
outlined in Section 3.1.3 or Section 3.1.4. This will permanently configure the LaunchPad to act as a USB-to-
I12C adapter and will not be necessary for subsequent sessions.

5. Set S2 to the active position. The D1 LED will indicate when power is supplied to the socket.

6. Verify the connection status of the adapter in the bottom left corner of the GUI window. If Hardware not
Connected is displayed, toggle the connection icon once to refresh the adapter connection. With the D1 LED
active and the adapter recognized by the GUI, 12C communication should be available to the PMIC. The
adapter will disconnect if I2C communication fails. Verify that the 12C pull-up voltage is available (J12 and
VIO test point) if the GUI consistently disconnects after read or write attempts.

7. Navigate to the Register Map or Device Configuration page, and select the Read All Registers button in the
top right corner of the GUI window.

8. The Register Map will populate with the returned values as the PMIC replies to the 12C read requests. The
Register Map can directly interact with the PMIC through drop down menus for each register field or by
directly writing into the value column for the individual registers. For a graphical representation of common
device settings, select the slider icon below the pencil icon in the left toolbar to navigate to the Device
Configuration view. These visual indicators are linked directly to the respective bits or bitfields in the register
map.

9. Selecting the tabs at the top of the Device Configuration view will navigate through the categorized register
fields.

10.By default, the Control and Configuration registers of the PMIC are always locked after a re-start event,
preventing accidental I12C writes to the device. The check-boxes in the top right corner of the Device
Configuration view can verify if critical registers are accepting write instructions from the 12C master. These
check boxes can also be used to lock and unlock the associated registers.

11.By default, certain regulators are dependent on either the status of SEQ (S1), or the status of SEQ and GPIO
(S3). All sequencing dependencies are visible in the regulator's respective tab, or by using the Sequencing
Overview tab within the Device Configuration view.

12.When registers are unlocked, any changes to the device registers will take effect immediately.

13.The PMIC will always return to default settings if a fault occurs that forces a transition to the RESET state.

14.Register changes will not be stored in EEPROM unless the programming instruction has been sent to the
PMIC through the 12C.

15.The EEPROM is programmed when a hex value of 0x2D is written to register 0x4A. In the GUI, this can be
done directly through the register map or by clicking the Flash EEPROM button in the Re-Program PMIC
view of the GUI.
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Figure 5-1. BOOSTXL-TPS65033 LaunchPad and Socket Connections
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Figure 5-2. BOOSTXL-TPS65033 Power Supplies
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6 BOOSTXL-TPS65033 Board Layers
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7 BOOSTXL-TPS65033 Bill of Materials
Table 7-1. BOOSTXL-TPS65033 Bill of Materials (BOM)
Designator |Quantity Value Description Package Reference Part Number Manufacturer
IPCBA1 1 Printed Circuit Board BMC059 Any
C1,C7 2 1 uF CAP, CERM, 1 yF, 35V, £ |0402 GRM155R6YA105ME1 |MuRata
20%, X5R, 0402 1D
C2 1 150 uF CAP, TA, 150 uF, 6.3V, = |3528-21 T520B157M0O06ATE025 | Kemet
20%, 0.025 Q, SMD
C3, C6 2 0.1 uF CAP, CERM, 0.1 pF, 10V, |0402 885012105010 Waurth Elektronik
+ 20%, X5R, 0402
C4,C5,C11,|4 10 uF CAP, CERM, 10 pyF, 10V, |0402 CLO5A106MP5NUNC | Samsung Electro-
C14 + 20%, X5R, 0402 Mechanics
Cc8 1 0.1 uF CAP, CERM, 0.1 pyF, 50 V, |0402 CGA2B3X7R1H104M0 | TDK
+ 20%, X7R, AEC-Q200 50BB
Grade 1, 0402
C9, C12, 3 10 uF CAP, CERM, 10 yF, 25V, |1210 CGA6P1X7R1E106M2 | TDK
C13 + 20%, X7R, AEC-Q200 50AC
Grade 1, 1210
Cc10 1 10 yF CAP, CERM, 10 pF, 10 V,+ | 1206 LMK316AB7106MLHT |Taiyo Yuden
20%, X7R, AEC-Q200
Grade 1, 1206
C15, C17 2 10 uF CAP, CERM, 10 pF, 6.3 0805 JMJ212CB7106KGHT | Taiyo Yuden
V,£ 10%, X7R, AEC-Q200
Grade 1, 0805
C16,C18, |4 1 uF CAP, CERM, 1 yF, 10 V, £ |0603 LMK107B7105KAHT Taiyo Yuden
C19, C20 10%, X7R, AEC-Q200
Grade 1, 0603
D1 1 Green LED, Green, SMD 0.8x1.6 mm HSMG-C190 Avago
HA1 1 IC to place in Socket XU1 TPS650330QRGEQ1 | Texas Instruments
J1 1 Header, 100 mil, 2x1, Tin, |Header 2x1 90120-0122 Molex
TH
J2 1 Header, 100 mil, 3x2, Tin, |3x2 Header PECO03DAAN Sullins Connector
TH Solutions
J3, J4 2 Receptacle, 2.54 mm, 10x2 Receptacle SSQ-110-03-T-D Samtec
10x2, Tin, TH
J5, J12 2 Header, 100 mil, 2x1, Tin, |Header, 2 PIN, 100 mil, PEC02SAAN Sullins Connector
TH Tin Solutions
J7, J9 2 Header, 100 mil, 3x1, PBCO3SAAN PBCO3SAAN Sullins Connector
Gold, TH Solutions
J11 1 Header, 100 mil, 4x2, Tin, |Header, 4x2, 100 mil, Tin |PEC04DAAN Sullins Connector
TH Solutions
L1 1 1.5 uH Inductor, Shielded, Metal |0806 TFM201610ALMA1R5 |TDK
Composite, 1.5 yH, 2.3 A, MTAA
0.11 Q, AEC-Q200 Grade
0, SMD
L3, L4 2 1uH Inductor, 1 uH, 3.1 A, 0.06 |2.0x1.6x1.0 mm TFM201610GHM-1R0 | TDK
Q, SMD MTAA
Q1 1 25V MOSFET, N-CH, 25V, 5 DQK0006C CSD16301Q2 Texas Instruments
A, DQK0006C (WSON-6)
R1, R2 2 100 k RES, 100 k, 5%, 0.1 W, 0603 CRCWO0603100KJNEA | Vishay-Dale
AEC-Q200 Grade 0, 0603
R3 1 1.5k RES, 1.5k, 5%, 0.063 W, |0402 CRCWO04021K50JNED |Vishay-Dale
AEC-Q200 Grade 0, 0402
R4 1 680 RES, 680, 5%, 0.1 W, 0603 RC0603JR-07680RL Yageo
0603
R5, R6 2 4.7k RES, 4.7 k, 5%, 0.1 W, 0603 RC0603JR-074K7L Yageo
0603
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Table 7-1. BOOSTXL-TPS65033 Bill of Materials (BOM) (continued)

Designator |Quantity Value Description Package Reference Part Number Manufacturer

R7,R8,R9 |3 0 RES, 0, 5%, 0.063 W, 0402 RC0402JR-070RL Yageo America
0402

S1,S3 2 Switch, Slide, SPDT, On- |9.5x5 mm AS1E-2M-10-Z Copal Electronics
Off-On, 3 Pos, 0.05 A, 48
V, TH

S2 1 Switch, Slide, SPDT, 0.2 |SMD, 3-Leads, Body CL-SB-12A-01T Copal Electronics
A, J Lead, SMD 8.5x3.5 mm, Pitch 2.5 mm

SH-J1, SH- |8 1x2 Shunt, 100 mil, Flash Closed Top 100 mil Shunt |SPC02SYAN Sullins Connector

J2, SH-J3, Gold, Black Solutions

SH-J4, SH-

J5, SH-J6,

SH-J7, SH-

J8

TP1, TP2, 18 PCB Pin, Swage Mount, |PCB Pin(2505-2) 2505-2-00-44-00-00-07- | mill-Max

TP3, TP4, TH 0

TP5, TP6,

TP7, TPS,

TP9, TP10,

TP11, TP12,

TP13, TP14,

TP15, TP16,

TP17, TP18

U1, U2 2 5.5V, 2A, 38 mQ Load YFPOO04AAAA TPS22915CYFPR Texas Instruments
Switch With Quick Output
Discharge, YFPOO04AAAA
(DSBGA-4)

XU1 1 Socket, QFN-24, 0.5 mm | Socket, QFN-24, 0.5 mm |QFN-24BT-0.5-01-00 Enplas Tech Solutions
Pitch Pitch
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8 Revision History
NOTE: Page numbers for previous revisions may differ from page numbers in the current version.

Changes from Revision * (April 2019) to Revision A (October 2020) Page
» Changed the title from TPS65033x Programming Board Users Guide to BOOSTXL-TPS65033 EVM User's
T o = SRRSO 1
» Updated the numbering format for tables, figures, and cross-references throughout the document.................. 1
o Updated the ADSIrACt SECHON..........ueiiie ettt e ettt e e s sttt e e e s aab et e e e s sbbeeeeeesabeeeeeeanbeeeeeens 1
» Changed the part numbers from TPS650320 and TPS65033x to TPS65032001-Q1 and TPS65033x-Q1
throughOUt the USEI'S QUIE.........co it e e e e e e ettt e ettt e e e s e s e e eeeaaaaaaeaeaeeeeeeensnnnns 1
* Updated links in the BOOSTXL-TPS65033 Components and Environment Section.............cccccceeeeeeeiieccnnnnnen. 2
» Updated the Critical Socketed Board CONNECtioNS SECHON. ..........uuiiiiiiiieaiieiieeee e a e e e 3
o Updated the PoOWer SWiItCHES SECHION............iii it e e st e s s nbbe e e e s anneeeens 4
* Updated the Finding the GUI SECHON............cccieeeee et e e e e e e e e s e e e e e e e e eaaaeeeaaaaanns 5
* Updated the Offline INStallation SECHON.................uuuiiiiiiii e e e e e e e e e e e e e e e e e e eaanns 5
* Added the Flashing the MSP432E401Y Launch Pad SECHON............cccoiiiiiiiiiiiiiec et 6
* Updated the Basic Operation of the GUI SECHON..........ccuiiii it 10
o Added the HOME SECHON........coiiiii ettt e e e e e e e e e et e e e e e e e e e e e aben b eeeeeeas 10
o Added the BIOCK Digram SECHON.......c.oi ittt e e e e e e et e ettt e e e e e e e e e e s s e annbnreeeeeeaaaeeeeaaaannnes 11
o Added the REgiISIErS SECHON. .......cii et e et e e e e r b e e e e e e a e e e e e aareeas 11
* Added the Device Configuration SECHOM..........icuuuiii ittt et e e s st e e e s anbee e e e s annbeeaesennneeens 12
* Added the Using Device Configuration to Define Spin Settings SECON...............cocciiiiiiiiiieieee e 12
* Added the Configuring the Power SeqQUENCE SECHON...........ccccuiiie et e e e enree e e e ennees 12
LRI O oTo =1 (Yo It g 1= TN ot o) T ==Y} o] o 1P 16
» Updated the Recommended Operation Procedure SECHON............cccuu it e e e e 19
* Added the BOOSTXL-TPS65033 SChematiC SECHON........c.uueiieiiiiiiee e eetiiee ettt e e et e e e snneeee e 20
* Added the BOOSTXL-TPS65033 Board Layers SECHON..........cccuuiieeeiiiiieeeeeiiiee e s seiiieeeesetteeeesssnteeeeessnaeeeaeannes 22
* Added the BOOSTXL-TPS65033 Bill of Materials SECHON...........coi i 26
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IMPORTANT NOTICE AND DISCLAIMER

TI PROVIDES TECHNICAL AND RELIABILITY DATA (INCLUDING DATA SHEETS), DESIGN RESOURCES (INCLUDING REFERENCE
DESIGNS), APPLICATION OR OTHER DESIGN ADVICE, WEB TOOLS, SAFETY INFORMATION, AND OTHER RESOURCES “AS IS”
AND WITH ALL FAULTS, AND DISCLAIMS ALL WARRANTIES, EXPRESS AND IMPLIED, INCLUDING WITHOUT LIMITATION ANY
IMPLIED WARRANTIES OF MERCHANTABILITY, FITNESS FOR A PARTICULAR PURPOSE OR NON-INFRINGEMENT OF THIRD
PARTY INTELLECTUAL PROPERTY RIGHTS.

These resources are intended for skilled developers designing with Tl products. You are solely responsible for (1) selecting the appropriate
TI products for your application, (2) designing, validating and testing your application, and (3) ensuring your application meets applicable
standards, and any other safety, security, regulatory or other requirements.

These resources are subject to change without notice. Tl grants you permission to use these resources only for development of an
application that uses the Tl products described in the resource. Other reproduction and display of these resources is prohibited. No license
is granted to any other Tl intellectual property right or to any third party intellectual property right. Tl disclaims responsibility for, and you
will fully indemnify Tl and its representatives against, any claims, damages, costs, losses, and liabilities arising out of your use of these
resources.

TI's products are provided subject to TI's Terms of Sale or other applicable terms available either on ti.com or provided in conjunction with
such Tl products. TI's provision of these resources does not expand or otherwise alter TI's applicable warranties or warranty disclaimers for
TI products.

Tl objects to and rejects any additional or different terms you may have proposed.
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